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Introduction

What is the T32 Smart 1-Wire® Temperature Sensor?

The AquiStar® T32 Smart 1-Wire® Temperature Sensor is a submersible pH/temperature
sensor and datalogger combined in one small diameter unit. The T32 records 61,000 to
698,000 records (depending on the number of 1-Wire sensing units), operates on low
power, and features easy-to-use software with powerful features.

The T32 measures temperature using low-cost, highly accurate 1-Wire technology. Up to
32 sensing units can be attached to any one T32 recording unit.

The T32 Smart Sensor is powered with two AA alkaline batteries or with an auxiliary
power supply for data intensive applications. The unit is programmed using a laptop or
desktop Windows® based computer via its RS485/RS232 adaptor and INW’s Aqua4Plus
software. Once programmed, the unit will measure and collect data on a variety of time
intervals. Direct read registers are also available on the T32, so you can read the
temperature values using other Modbus® RTU devices.

Several T32’s, or a combination of T32’s and any other AquiStar Smart Sensors, can be
networked together and controlled from one location, either directly from a single
computer or via INW’s WaveData® Wireless Data Collection System.

Initial Inspection and Handling

Upon receipt of your smart sensor, inspect the shipping package for damage.  After
opening the carton, look for concealed damage, such as a cut cable. If damage is found,
immediately file a claim with the carrier.

Do’s and Don’ts

Do handle the device with care.

Don’t bang or drop the device on hard objects.
Don’t install without the screw cap secured to the top of the tube enclosure.
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Installation and Operation

Installing the T32

Prior to shipping your T32, INW engineers will work with you to determine the best
configuration for your application. Depending on your particular application, the T32
may or may not come with the 1-Wire units connected. If they are not connected, INW
will provide documentation specific to your configuration.

Connecting External Power

The T32 comes with two AA internal batteries. If auxiliary power is desired, you can use
a 6 - 13 VDC supply that can provide 15 mA. See wiring information later in this manual.

Connecting the T32 to a Computer

The T32 is terminated with a weather-resistant connecter inside a screw-cap. Connect
the weather-resistant connector to your PC or laptop serial port via the interface cable
and an RS485/RS232 adapter, as shown below. For USB connections, see Appendix C.

Connect the sensor to your computer using the interface cable and an RS485/RS232
adapter. See Appendix C for details on connecting using a USB Port.

RS485/RS232
AdapterWeather-

resistant
Connectors

Serial Port

T32
Datalogger

Interface Cable

PC or
Laptop

Computer

1-Wire
String

Screw-

T32

cap
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Installing the Aqua4Plus Software

What is Aqua4Plus?

Aqua4Plus is INW’s easy-to-use Windows-based software for communicating with and
controlling INW’s state-of-the-art Smart Sensors.

The T32 comes with the Aqua4Plus host software that is installed on your PC or laptop.
Use this software to program the datalogger, to retrieve data from the logger, to view
collected data, and to export data to external files for use with spreadsheets or data-
bases.

Refer to the Aqua4Plus software manual for details on installing and using Aqua4Plus.

Using the T32 Without Aqua4Plus

If you want to access the T32 data via the Modbus® protocol and your
own software or if you want to display readings on a panel meter, please contact INW
for details.

Selecting Channels and Assigning Channel Labels

Selecting Channels
Each T32 sensor can read up to 32 1-Wire temperature sensors. By default, the software
uses all 32 channels, whether or not there are sensors connected to all 32. If INW
configures your system, all unused channels will be turned off. If you are configuring
your own system, or if you want to change the configuration of your current system,
use the Advanced Calibration option to select which channels you want to be active.

There are two advantages to turning off unused channels. First, all displays and output
files will show only those you have turned on, thus eliminating extraneous data. Second,
the fewer channels that are active, the more records can be stored on the sensor.

The Advanced Calibration option is only available if there are no sessions stored on the
sensor.  If there are any sessions stored on the sensor, upload any data you want and
then erase the sessions before continuing. (Sessions Menu | Erase All Sessions)

On the sensor map, select the desired sensor. Next, select Advanced from the Configura-
tion Menu, and then select Advanced Calibration. You will be asked for a password. The
default password is admin. (This can be changed from Options Menu | Change Pass-
word.) The Advanced Calibration window will appear.

On the left there is a list of all possible channels. Click to checkmark those channels that
you are using, and then click OK. (If you need to change any of the advanced
calibration data, contact INW for further instructions.)
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Assigning Channel Labels
Each channel on a T32 has a unique label. By default, these labels are Temperature 1,
Temperature 2, etc., corresponding to the channels on the board itself.  These labels
display on the Real Time Monitor as well as the data and graph displays. To assign
more meaningful names to each active channel,  use the Field Calibration option from
the Configure menu.

The Field Calibration option is only available if there are no sessions stored on the
sensor.  If there are any sessions stored on the sensor, upload any data you want and
then erase the sessions before continuing. (Sessions Menu | Erase All Sessions)

On the sensor map, select the desired sensor, and then open the Field Calibration
window. Click on each channel you want to label. Type in a name in the Channel Label
field. When you finish changing the labels, click on OK.

Field Calibration

If desired, each individual channel can be calibrated using the Field Calibration option
(Configure Menu | Field Calibration.) You can perform either a one- or a two-point
calibration.

Calibration can only be done when there are no sessions stored on the sensor. If there
are any sessions stored on the sensor, upload any data you want and then erase the
session before continuing.

To do this calibration you will need an accurate temperature reference, such as a digital
thermometer, and an environment where the temperature can be changed and stabilized
or two different environments with two different temperatures.

Preparation:
• Run Aqua4Plus and scan for sensors.
• On the Sensor Map, click the sensor you want to calibrate.
• From the Options Menu, select the units you want to use to measure temperature,

i.e., degrees Celsius,  degrees Fahrenheit, or degrees Kelvin.
• From the Configure Menu, select Field Calibration.
• Click on Pressure in the left panel.

One-Point Calibration:
— Computing Calibration Value —
• Place sensor in calibration environment. Allow time for thermal stabilization.
• Using an accurate alternate measurement device, measure the temperature of the

environment.
• In the Ref  box for the first point, enter this temperature.
• Click first Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the

pop-up box.
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— Applying Calibration Value —
• Click the Apply button to apply calibration value.
• The computed b value will be transferred to the calibration field.
• Click OK to save the value to the sensor.

— Verifying Calibration Value —
• Using the Real Time Monitor, take a few readings while the sensor is still at the

precise known temperature. Readings should be very close to that temperature.

Two-Point Calibration:
— Compute First Calibration Point —
• Place sensor in first calibration environment. Allow time for thermal stabilization.
• Using an accurate alternate measurement device, measure the temperature of the

environment.
• In the Ref  box for the first point, enter this temperature.
• Click first Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the

pop-up box.

— Compute Second Calibration Point —
• Place sensor in second calibration environment. Allow time for thermal

stabilization.
• Using an accurate alternate measurement device, measure the temperature of the

environment.
• In the Ref  box for the second point, enter this temperature.
• Click second Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the

pop-up box.

— Applying Calibration Values —
• Click the Apply button to apply calibration values.
• The computed m and b values will be transferred to the calibration fields.
• Click OK to save the values to the sensor.

— Verifying Calibration Values —
• Using the Real Time Monitor, take a few readings while the sensor is still at the

second precise known temperature. Readings should be very close to that
temperature.
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Collecting Data

Following is a brief overview on using Aqua4Plus to collect data. Please refer to the
Aqua4Plus Instruction Manual for further details on configuring and using Aqua4Plus.

Real Time Monitor

Click Single to get a single reading.

Click Start to get a reading once a second.

Click Stop to stop the reading.

Note: These are snapshot readings and are not recorded on the sensor.

The Real Time Monitor gives a snapshot of the
current readings on the sensor.
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Setting up a Data Recording Session

Click the  tool button. A Session Profile Window will open. Refer to the Aqua4Plus
Instruction Manual for details in describing your session profile. Click the Start button
to save the session to the sensor and begin recording.

Using the Session Profile Window, describe
the test steps for your particular test.

Retrieving Data from the Sensor/Datalogger

• Click on the session you want to upload.

• Click the   tool button.

• Select a file location.

• Click Save.

• Click Start.

Select the data session you are
ready to upload.
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Viewing Data

• Click the   tool button to view data as a table.

• Click the   tool button to view data as a graph.

• Navigate to the desired file, then click the Open button. (If the File Open box does
not appear, click the File Menu, then select Open.)

The File Display window displays your
data in a tabular format.

The Graph Window displays your data on an X Y
coordinate graph.



11
Exporting Data to .csv or .xls Files

• Using the File Display window, open the file you want to export.

• Click on the   tool button.

• Select a file location and enter a name for the file.

• Select a file type.

• Click Save.

A Word About  Units

Readings from the T32 can be displayed in various units, such as degrees Celsius,
degrees Fahrenheit, or degrees Kelvin. Select the units you want from the Options |
Units menu.
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Appendix A: Technical Specifications

General Specification
The AquiStar® T32 is a microprocessor based digital intelligent datalogger designed to
measure and record temperature, utilizing state-of-the-art low power, battery operated
circuitry and 1-Wire sensor element technology.

The microprocessor on the circuit board obtains readings from the sensors, stores the
data in on-board non-volatile memory, and communicates the information via a serial
communication link (RS485) to the host computer or to a WaveData® Wireless network.

Wiring and Component Information

T32 Communication Connector Wiring Information:

Connector Pin Function
1 = Vaux (6 - 13 VDC)
4 = Digital out (not used)
5 = Ground
3 = Comm D+
2 = Comm D-

Mechanical:
Datalogger Enclosure
Dimensions 11.035” x 0.75” - cableless version

11.260” x 0.75” - cabled version
Enclosure Material 316 stainless steel or titanium
Wire Seal Materials Viton® and PTFE/FEP
Weight .80 lbs.

Sensor String Cable
OD 0.25” maximum
Break Strength 100 lbs.
Maximum Length 325 feet
Weight 4 lbs. per 100 feet

Operating Specifications:
Accuracy ±0.2° C (at 25° C)
Resolution 0.1 ° C
Temperature Range -40° C to +125° C

Power Supply
Internal 2 AA Alkaline batteries
Auxiliary 6 - 13 VDC, 15 mA
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Appendix B: Changing Batteries

Because changing the batteries involves opening the water-tight seal, this must be done
in a clean, dry environment to avoid contamination or moisture damage to the circuitry.

The T32 uses two standard AA Alkaline batteries.

Opening the Housing
Open the housing by removing the top-cap, as outlined below. The top-cap is the
connector between the tube housing the datalogger and the screw cap covering the
communication port.

1. Push down and then twist gently to unscrew the top-cap.

2. Gently separate the top-cap from the body of the tube.  Top-cap remains attached
to body via several  colored wires.

Caution! Pulling forcefully on the top-cap can pull out the insides or snap
the connections inside. Removing the circuit board may void your
warranty.

Note: O-rings provide a water-tight seal for the sensor housing. Take care
not to nick or otherwise damage  these O-rings.

Replacing the Batteries

3. Tip housing over and gently slide batteries out.

4. Insert new batteries - positive terminals towards top cap.

5. Replace and retighten top cap.
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Appendix C: Using USB-to-Serial Cables

The standard communication cable/RS485-232 adapter that comes with the Smart Sensor
plugs into a 9-pin serial port on the PC or laptop. Many new computers, especially
laptops, do not come with 9-pin serial ports. If you have one of these computers, or if all
of your serial ports are in use, you can connect to a Smart Sensor using a USB-to-serial
cable, as shown below.

Connect the sensor to your computer using the interface cable, an
RS485/RS232 adapter, and a USB-to-Serial cable. (See Installation
section earlier in this manual if you want to connect via a serial port.)

USB-to-serial cables are readily available from many electronics and computer stores, as
well as numerous sites on the Internet. INW has tested and recommends the Keyspan
USA-19HS. It is available from INW or on the Internet. Install as follows:

• Plug into USB port.

• Install the drivers provided with the particular unit. (If using Windows® Vista or
Windows® 7, you will need to download the Vista drivers from Keyspan’s web
site at www.tripplite.com/en/support/downloads.)

• Determine the port number to which the adapter is assigned.
 Right-click on My Computer.
 From the popup menu, select Manage to open the Computer Management

window.
 On left panel, click on Device Manager.
 On right panel, double-click on Ports.
 A list of active COM ports will be displayed. Note the COM number assigned

to the adapter you just installed.

For example: 
 Close Manager.

Screw-

T32

cap

PC or Laptop
Computer

USB PortUSB-to-Serial
CableInterface

Cable

Weather-Resistant
Connectors

T32
Datalogger

RS485/RS232
Adapter

1-Wire
String
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Reordering Information

For sales & service offices, please contact:

Instrumentation Northwest, Inc.
www.inwusa.com

800-776-9355

• Connect to the T32.

• On the Aqua4Plus software, select the COM port noted above. (If you do not see
your new COM port in the drop-down box, open the Communications dialog box
from the Options menu. Increase the Highest COM port number.)
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LIMITED WARRANTY/DISCLAIMER -
AquiStar® T32 SMART TEMPERATURE SENSOR

A. Seller warrants that products manufactured by Seller when properly installed, used
and maintained, shall be free from defects in material and workmanship.  Seller’s
obligation under this warranty shall be limited to replacing or repairing the part or
parts or, at Seller’s option, the products which prove defective in material or workman-
ship within ONE (1) year from the date of delivery, provided that Buyer gives Seller
prompt notice of any defect or failure and satisfactory proof thereof. Any defective part
or parts must be returned to Seller’s factory or to an authorized service center for
inspection. Buyer will prepay all freight charges to return any products to Seller’s
factory, or any other repair facility designated by Seller. Seller will deliver replace-
ments for defective products to Buyer (ground freight prepaid) to the destination
provided in the original order. Products returned to Seller for which Seller provides
replacement under this warranty shall become the property of Seller.

This limited warranty does not apply to lack of performance caused by abrasive
materials, corrosion due to aggressive fluids, mishandling or misapplication. Seller’s
obligations under this warranty shall not apply to any product which (a) is normally
consumed in operation, or (b) has a normal life inherently shorter than the warranty
period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written
approval by the Seller, all warranties are void. Equipment and accessories not manufac-
tured by the Seller are warranted only to the extent of and by the original manufacturer’s
warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES,
WHETHER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY. IMPLIED
WARRANTIES OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY.
SELLER’S WARRANTY OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER
(EXCEPT AS TO TITLE) ARE SOLELY AND EXCLUSIVELY AS STATED HEREIN. IN
NO CASE WILL SELLER BE LIABLE FOR CONSEQUENTIAL DAMAGES, LABOR
PERFORMED IN CONNECTION WITH REMOVAL AND REPLACEMENT OF THE
SENSOR SYSTEM, LOSS OF PRODUCTION OR ANY OTHER LOSS INCURRED
BECAUSE OF INTERRUPTION OF SERVICE. A NEW WARRANTY PERIOD SHALL
NOT BE ESTABLISHED FOR REPAIRED OR REPLACED MATERIAL, PRODUCTS OR
SUPPLIES.   SUCH ITEMS SHALL REMAIN UNDER WARRANTY ONLY FOR THE
REMAINDER OF THE WARRANTY PERIOD ON THE ORIGINAL MATERIALS,
PRODUCTS OR SUPPLIES.

B. With respect to products purchased by consumers in the United States for personal
use, the implied warranties including but not limited to the warranties of merchantability
and fitness for a particular purpose, are limited to twelve (12) months from the date of
delivery.

Some states do not allow limitations on the duration of an implied warranty, so the
above limitation may not apply to you. Similarly, some states do not allow the exclusion
or limitation of consequential damages, so the above limitation or exclusion may not
apply to you. This limited warranty gives you specific legal rights; however, you may
also have other rights which may vary from state to state.
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